
5 
Data Entry Panels 

Chapter 5 examines procedures for constructing the Data Entry panel that is the runtime 
form for a Verification Task Project – and a Verify task’s processing dialog. It also looks 
at ways to modify a panel’s content and format. 

The chapter covers these topics: 

I. Introduction ............................................................................................................. 5-2 

II. How to Construct a Data Entry Panel ................................................................... 5-3 
A. Autoform............................................................................................................ 5-5 

III. Configuring the Data Entry Panel.......................................................................... 5-8 
A. Panel Controls and Properties ........................................................................ 5-9 
B. Tab Order Properties...................................................................................... 5-13 

IV. Practicing with Autoform ..................................................................................... 5-14 

V. How to Add Fields to a Data Entry Panel............................................................ 5-18 
A. Snippets and Data Edit Field Pairs ............................................................... 5-18 
B. Special Purpose Field Controls: OMR, Dictionary,  

and Database Lookup Fields......................................................................... 5-21 

VI. How to Add a Magnifying Lens to a Data Entry Panel’s Image Control .......... 5-25 

VII. Hot Keys of the Data Entry Panel ........................................................................ 5-27 
A. Procedures and their Hot Keys ..................................................................... 5-27 
B. Hot Keys and their Procedures.....................................................................5-30 

 

Important! This chapter does not always use the 1040EZ training application for all 
examples. Often, the chapter uses a new but fictional application to present the start-to-
stop sequence involved in defining, testing and implementing a Data Entry panel. 
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Introduction 

Introduction 
Most (but not all!) Verification task operations take place within a Data Entry panel that 
rests inside the Batch Pilot Window. The panel displays data and images drawn from a 
single source page; the window lists the contents of the batch as a series of documents 
and pages.  

The operator uses navigation tools of the panel to move from field to field within a page– 
and the window’s tools to move from page to page, and document to document - until 
verification of the batch is complete. 

Here is a basic example: 

 
MQSW Application – Data Entry Panel 

9 A Data Entry form may have other roles. Alternative configurations of the form used by 
the Taskmaster for Invoices application help an operator construct new Vendor Records 
and invoice “fingerprints”. 
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How to Construct a Data Entry Panel 
A Task Project requires a Document Hierarchy (Chapter 4).  

After the Verification Task Project’s structure is in place inside the Batch Pilot Window, 
select Setup Tree from the window’s View menu. The Document Hierarchy will appear 
below the Setup Tree’s SetupForm node in the Batch View area in the bottom left-hand 
corner: 
 

 

Setup form 
     SetupForm 
                node 

       Document 
       Hierarchy 

Batch Pilot Window - Batch View area 

9 Very important! In the example above, a setup form is “bound” to the SetupForm node. 
However, unlike Task Projects for most tasks, the Batch object of the Document 
Hierarchy (MQSW, in this case) does not yet have a runtime form. 

This is because: 

• A new Data Entry panel – rather than a stock form - will be the project’s 
runtime form; 

• The Data Entry panel will be linked to a specific Page object of the Document 
Hierarchy rather than to the Batch object, because the panel processes individual 
pages rather than contents of the entire batch; 

• The panel has not yet been generated. 

Take a closer look at the levels of the sample MQSW hierarchy: 

♦ At this early stage, no forms are bound to any objects of the Document 
Hierarchy. 

♦  Questionaire_601 is a Document object with two Page objects: Front and Back. 
However, only the fields of the Front page have data that is subject to 
verification. 
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How to Construct a Data Entry Panel 

 

                 Page 

• The Front page has seven Field objects: 

 

                Page  

• Four Field objects represent Optical Mark Recognition (OMR) fields.  
                Page 

Page
 

    OMR  
   Fields 
 
• Each OMR field has values of a pre-defined Dictionary assigned to its checkbox 

options (Q1_OMR1 – Q1_OMR4.) 
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Autoform 
Batch Pilot uses an Autoform utility that responds to the Document Hierarchy’s structure 
and content as it produces a Data Entry panel for the Verify task’s Task Project – and, 
therefore, for the project’s Verify task. 

9 However, Autoform can solicit information about the structure, contents and properties of 
a Page object only when it prepares a Data Entry panel (see the next page).  

In the example on the previous page, Autoform will put together a panel with seven field 
pairs – each pair made up of a snippet field and a Data Edit field - for the Front page. 
Each pair will be accompanied by a label. 

The Data Edit members of the OMR field pairs will be drop-down lists containing the 
four values of the pre-defined dictionary: Excellent, Good, Fair and Poor – along with a 
Blank option.  

To put together a Data Entry panel with Autoform, take these steps (using MQSW as an 
example): 

Step Action 

1. Open the Verify Task Project (.bpp) you previously defined (Chapter 4). 

2. Select Setup Tree from the Batch Pilot Window’s View menu. 

3. Expand the Task Project’s Document Hierarchy. 

4. Highlight the Page object with fields that are to be part of the Data Entry 
panel (Front, in the example below). 

 

5. Right-click on the highlighted listing. 

 

Select this 
option. 
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How to Use Autoform to Generate a Data Entry Panel (continued) 

Step Action 

6. Select Autoform from the options. 

7. Batch Pilot Window’s Data Area, in its Design mode (Chapter 2). 

8. Un-toggle the View menu’s Design option for a look at the new Data Entry 
panel in its Operating mode.  (In this example, clicking on a drop-down list 
field – Q1, for example – reveals the field’s five options.) 

9. The Data Entry panel is a new Datacap form (dcf). Use the File menu’s Save 
Form item to save the form to the Verify folder of your application’s Process 
directory. Alert! This form is not a stock form and does not belong with other 
stock forms in the BPilot directory. Instead, place the form in an application 
folder. 

10. Close the Verify Task Project. 

 
Front Page Data Entry Panel – Design mode 
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Front Page Data Entry Panel – Operating mode 

9 Why not practice with the Autoform utility as you learn how to construct new Data Entry 
panels? The section on Page 14 shows you how to set up additional panels for the 
1040EZ training application. 
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Configuring the Data Entry Panel 

Configuring the Data Entry Panel 
9 A new Data Entry panel needs additional attention before an operator can use it 

effectively. In the example below: 

The labels do not clearly identify fields on an MQSW questionnaire. 

The snippets do not yet display images of values in their fields. 

It is difficult to discern how effectively the Data Edit fields will display their 
recognized data. 

The panel lacks an obvious tool to display the full image of the current Front page – 
the source page that is currently being processed by the Verify task. 
 

 
Front Page Data Entry Panel – Operating mode 

Most of your modification efforts will involve reviewing key properties of the panel’s 
controls to be sure they have been set up accurately. 

To begin, access your new Data Entry panel in Design mode: 

♦ In the Batch Pilot workshop, open the Verify Task Project (.bpp); 

♦ Select Setup Tree from the Batch Pilot Window’s View menu. 

♦ Right-click on the Page object that is the basis for the panel. 

♦  Select View form from the options. 
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Chapter 5: Data Entry Panels 

 

 

 

        DCImage DCEdit            Label 

MQSW Panel – Four Field Pairs 

Panel Controls and Properties  
A Data Entry panel consists of controls. 

The illustration above shows three controls for each of four field pairs associated with 
four Field objects of the Document Hierarchy. Autoform generates the controls; assigns 
their properties; and provides them with code.  

Each group has a label control, a DCImage control, and a DCEdit control. To view the 
properties of a control, right-click on it and select Properties from the list of options. 

To enhance the panel’s clarity, you may want to modify one or more values that 
Autoform has assigned to the Caption properties of the Label controls. 

 
Label Control – Caption property 
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Configuring the Data Entry Panel 

A snippet’s image resides within a DCImage control. Required properties of this control 
include: 

• ControlTipText: the Field object’s ID (Q_ID, in this case). 

• File Name: a value assigned by Autoform to the overall image of the 
fingerprint that represents this page. Alert! This is the File Name value for 
all DCImage controls except the first, which is blank.  

• Name: the DCImage designation (Dcim) combined with the Field object’s 
ID (Q_ID).  
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The interactive DCEdit control will hold a field’s recognized value – the value that is 
subject to change by an operator.  

• ControlTipText indicates the Field object’s ID (SurveyIDfr, in this case. 
(Note the change in the control’s label!). 

• Name links the type of control to the Field object’s ID – DcedSurveyID, in 
the example above but ComboQ1 below: 

 

9 Each control, of course, has other properties that may deserve your attention. One 
example: the ConfRequired property of a DCEdit control is a minimum Confidence 
Rating for values in the field. If the field’s recognized data is below this level, the Verify 
task usually changes the field’s background color to alert the operator to a problem. 

And there may be other fields you’d like to add – fields that are not represented by Field 
objects of the Document Hierarchy…fields for an operator’s comments or notes, perhaps. 
Page 18 shows you how to add and remove fields from a Data Entry panel. 

 

Confidential and Proprietary Information of Datacap Inc. Page 5–11 
Copyright © 2006 Datacap Inc. 



Configuring the Data Entry Panel 

The panel for the MQSW application’s Front page ended up looking like this: 
 

 
Data Entry Panel – MQSW Front Page 

When the Verify task actually runs, images will appear in the snippet fields on the left. 
Recognized data will appear in the Survey ID and Questionnaire ID Data Edit fields – 
and the operator will select an option from the drop-down lists for the Question fields. 

The operator can also use tools of the Batch Pilot Window to expand and magnify a 
snippet’s image or to review the full image of the current page. 
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Tab Order Properties 
An operator can tab quickly from one Data Edit field to the next. Two properties 
(illustrated below) determine the tabbing order: 

TabStop indicates whether or nor a field can participate.  

TabIndex specifies a field’s relative placement in the tabbing sequence. 

In this example, -1 - True is the TabStop value for each field, including the first Survey 
ID field and the four Question fields.   

9 However, when the panel’s designer removed the Data Edit field for the Anchor Field 
object – leaving only the image! – the TabIndex order was thrown off, and tests of the 
panel indicated that an operator could not tab from the Survey ID to Questionnaire ID.  
 

 
MQSW Front Page 

To remedy the problem, the designer checked the TabIndex property of each field in the 
sequence to be sure that the field had a lower value than the field that was to follow. She 
then right-clicked on the panel itself and selected Tab Order to confirm the sequence of 
the Dcedit and ComboBox controls.  
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Practicing with Autoform 

Practicing with Autoform 
The 1040EZ training application is nearly indestructible, so you can practice with 
Autoform over and over again until you are comfortable with its mechanics and results – 
a set of new Data Entry panels. 

9 As a preliminary step when constructing a practice panel, you first have to set up a 
second, practice 1040EZ Document Hierarchy with just a few objects. Be sure that you 
don’t delete the existing file: 1040EZ/xml. 

To define the new Document Hierarchy: 

Step Action 

1. Open the Workflow tab of the 1040EZ Taskmaster Administrator.  

2. Right-click on the application’s Workflow ID (1040EZ in this case).  

 

3. Select New and Workflow. 

4. Enter an ID for the new workflow. 

5. On the right, select TDCO as the Program Name. Press the Apply button and 
the Done button at the bottom of the tab. 
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To Establish the New Document Hierarchy (continued) 

Step Action 

6. Highlight the new Workflow ID and click on the Setup button on the right: 
this will open the Document Hierarchy Setup window. First, the window will 
list only the Batch object: DEP_PRAC, in the example. 

 

7. Right-click on an object at any level to add objects at the next level: Chapter 
3 of the Guide to Taskmaster Rules describes all features of this window.  

8. Save the new Document Hierarchy as an XML file in the 1040EZ 
application’s Process directory. 

 

 

Continued on the next page → 
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Practicing with Autoform 

Once the practice Document Hierarchy file in place, producing the Data Entry panel is 
straightforward: 

• Select New Project from the Batch Pilot Window’s File menu. When Batch 
Pilot asks you to identify the new Task Project’s Document Hierarchy file (.xml), 
locate and select the practice Document Hierarchy. 

• Select Save Project as… from the File menu to save the Task Project file (.bpp) 
in the application’s Process directory. 

• Close, and open, the practice Task Project. 

• In the Batch View area, bind a stock form such as verifysetup.dcf to the 
SetupForm. 

  
• Open the Document Hierarchy within the Batch View area. Right-click on the 

DEPrac_Page Page object and select the Autoform option. 

 
• Pause for an instant while Autoform assembles and presents you with a new Data 

Entry panel consisting of four field pairs – a snippet and a Data Edit field for 
each Field object in the practice Document Hierarchy.   

• Select Save Form from the window’s File menu to save the Data Entry panel as 
a Datacap Form (.dcf) in the 1040EZ application’s Process directory. 
Remember! This is the application’s form, not a stock form.   

• Close and open the Task Project (.bpp).  

• In the Batch View area, open the Document Hierarchy. Right-click on the 
DEPrac_Page Page object – and select View Form. When the Data Entry panel 
appears, un-toggle the Design item in the Batch Pilot Window’s Form menu for 
an un-hampered look at the panel and its fields. 
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Chapter 5: Data Entry Panels 

• Note, carefully, the information in the window’s Title bar. 

 
Data Entry Panel: 1040_dataentry_prac 

9 Take advantage of this procedure to practice producing a variety of new Data Entry 
panels.  
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How to Add Fields to a Data Entry Panel 
This section describes the steps you take to add a field pair – a snippet and a Data Edit 
field – to a Data Entry panel. Page 21 shows you how to add special-purpose fields such 
as OMR, drop-down list and database lookup fields. 

9 For those who intend to add a number of fields, we recommend that you add the 
applicable Field objects to the Document Hierarchy (Stage 1, below), and use the 
Autoform utility to produce a new panel (Page  5).  

Snippets and Data Edit Field Pairs 
Adding a field pair – a snippet and Data Edit field - to a Data Entry panel, is a procedure 
that takes place in five stages. Alert! Be sure to work in a Test environment when you 
begin this procedure.  

Stage 1: Add the Field Object to the Document Hierarchy 

If you are adding a brand new field such as “Comments”, insert its corresponding Field 
object in your application’s Document Hierarchy first: 

 

Status=0        New field! 

DEP_PRAC.xml – with Comments field 

Stage 2: Check the Field Object’s Status 

Check that the value of the Status property of the new Field object is “0”.   

Important! If Status is not listed as a default property of Field objects in the Document 
Hierarchy Setup window, use a text reader such as Notepad to open the Document 
Hierarchy file (.xml) located in the Process directory.  Scroll down to the field’s 
specifications and change the value of Status from “–1” to “0”. This allows the field to 
be represented in the Data Entry panel. 

Stage 3: Add Field Controls to the Data Entry Form 

The new field will require two field controls in the Data Entry panel. During processing: 
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• The Snippet will display an image of the field and its value in the current source 
page; 

• The Data Edit field will display the field’s recognized value. This is an 
interactive field control: after comparing the value in the Data Edit field to the 
image in the Snippet, the operator can correct the value in the Data Edit field, if 
necessary.    

You’ll add the controls above to the Datacap form (.dcf) that contains the panel’s 
structure and content. To access this form – 1040_DataEntry_Prac.dcf, in this case: 

♦ Open Batch Pilot. 

♦ Use the Open Form item in the Batch Pilot Window’s File menu to retrieve the 
form, which is in your application’s Process directory. 

♦ For extra caution, save the form as a different .dcf file  

♦ Move within the form to a “free” locale with plenty of space.  

9 To insert the controls, first… 

♦ Click on the Development Toolbox icon in the Batch Pilot Window’s toolbar, or 
select Toolbox from the Form menu. 

♦ Be sure the toolbox contains a DcImage icon and a DcEdit icon (Chapter 3). 

 

DcEdit        DCImage 

Development Toolbox 

If either is missing: 

♦ Right-click on the toolbox and select Additional Controls. 

♦ In the Additional Controls dialog, check the DcEdit control option and/or the 
Datacap Tiff Viewer Control option (which produces the DCImage icon.)  

Use the DCImage icon to place a rectangular Snippet control on the form, and the 
DcEdit icon to place a rectangular Data Edit field control just below the Snippet.  

Save the form! 
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Stage 3: Configure Properties and Events 

Each control has a unique set of properties. To review and modify these properties, right-
click on a control you’ve added to the form to access the Properties dialog for that 
control. 

9 Important! The new Snippet control (using the Comments field as an example) requires 
the following specific values for three specific properties: 

ControlTipText Comments 

FileName   DcimComments 

Name   DcimComments 

The Data Edit field control needs these values: 

ControlTipText Comments 

Name   Dced5Comments 

Be careful! Be sure to assign similar values to the properties of any new field pair –and 
do not deviate from the syntax in the example.  

Events associated with the Data Edit field control also need a few lines of helpful code. 
If you double-click inside the control after you’ve supplied new values for its properties, 
the form’s scripting mode moves into the forefront of the Batch Pilot Window: 

Add code similar to the code below to three events you can select from the drop-down list 
in the upper right-hand corner: Enter, KeyPress and NoMoreLCChars. 

Sub DcedComments_Enter() 
   DcceditEnter(me) 
End Sub 

Sub DcedComments_KeyPress() 
   Call stats_nKeyPress() 
End Sub 

Sub DcedComments_NoMoreLCChars() 
   Call NextLC(True) 
End Sub 

Stage 5: Bind the Modified Form to the Verification Task Project 

If you have been working with a completely “new” Data Entry form (.dcf), you have to 
bind it to the Verify task’s Task Project (.bpp). You can bind it to the existing project or, 
if you are being especially cautious, to a Task Project you have set up exclusively for 
development and testing.  
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If you are using a new form with a new name: 

♦ Open Batch Pilot and the Batch Pilot Window. 

♦ Select Open Project from the File menu; and open the applicable Verify Task 
Project. 

♦ Select Setup Tree from the View menu. 

♦ In the Batch View area at the bottom of the window, highlight the Page object 
just beneath the target document.  

♦ Right-click and select Pick Form. 

♦ When the Open dialog appears, select the appropriate .dcf file. This binds the 
form to the Page object. 

Special Purpose Field Controls: OMR, Dictionary, and 
Database Lookup Fields 

Because you set up fields in these categories outside of the Batch Pilot development 
workshop, the next few pages briefly describe the fields and tell you where to obtain 
complete explanations of fields in each category. 

9 Keep in mind that Autoform automatically adds these fields to the Data Entry panel as 
long as you define them before you create the panel. 

OMR Fields 

You use the Recognition Options Setup dialog accessible from the Fingerprints & Zones 
panel of the Rule Manager Window to construct a set of Optical Mark Recognition 
fields. In the example below, 

Tools of the dialog’s OCR/S tab of the Recognition Options Setup dialog add Optical 
Mark Recognition (OMR) Field objects to your Document Hierarchy quickly, easily and 
accurately. 

The default 1040EZ Document Hierarchy has four such fields: each contains a single 
checkbox a taxpayer or spouse can use to respond Yes or No to the Election Fund option. 

 

     OMR field 
Checkbox 

1040EZ OMR Fields 
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A Field object can take on OMR characteristics only if the OCR/S tab of the Recognition 
Options Setup dialog provides them. The settings for the TaxpayerElectionFundYES field 
look like this: 

   
Options Setup dialog – OCR/S tab 

9 Chapter 4 of the Guide to Taskmaster Rules describes these fields, and the steps you take 
to add them to your Data Entry panel. 

Dictionaries 

Values in a dictionary appear automatically when a panel’s Data Entry operator accesses 
a field with multiple pre-defined values. 

In the simple example below, YesNo is a single dictionary with two values that are 
assigned to that the TaxpayerElectionFind and SpouseElectionFund fields – and are 
listed when the 1040EZ Data Entry operator reaches these fields. 
 

  
1040EZ Dictionary: Yes, No  
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The Express application employs two dictionaries: 

 
YearDict and Operator_Dict Dictionaries -  

Express Application

9 Dictionary is a property of the applicable Field object of the Document Hierarchy; 
although individual dictionaries can be defined in the Document Hierarchy Setup 
window, it’s easier to use OCR/S tab of the Recognition Setup Options dialog.  Chapter 4 
of the Guide to Taskmaster Rules explains both approaches. 

Database Lookup Fields 

The upper portion of the standard Taskmaster for Invoices application’s Data Entry panel 
features two Database Lookup fields: Vendor Name and Vendor ID.  

 
InvoiceRule Database: Host table 

The underlined labels identify the fields’ special purpose. When the operator clicks on a 
title, a row of the Host table of the application’s Rules database appears – or all rows, 
depending on the circumstance. (The Host table contains vendor information.) If 
appropriate, the operator can change a field’s value in the panel. 
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The panel’s Vendor Name control has these special properties: 

• Name: LookUpVendorName 
• Font:  Underlined 

 

 
Properties – VendorName label 

When you double-click on the label when Batch Pilot is in Design mode, the Label 
control’s Click event has this code (bold type is for emphasis): 

Sub LookupVendorID_Click() 

Call Lookup2Dlg(DcedVendorID,"<SQL flist='VendorID, 
VendorName,VendorStreet,VendorCity,VendorState,VendorPos
talCode' dsn='InvoiceLook'>SELECT TOP 10 
vt_RefID,vt_RefName,vt_Street,vt_City,vt_State,vt_Zip 
FROM VendorTable WHERE vt_RefID like 
'@@VendorID@@'</SQL>") 

End Sub 

In this example, when the operator selects the Vendor Name label, the Data Entry panel 
uses a LookUp dialog to list data from the first ten Vendor Records in Vendor table of the 
Taskmaster for Invoices Lookup database.  
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How to Add a Magnifying Lens to a Data Entry Panel’s 
Image Control 

It is possible to project a Magnifying Lens within the Image control via two calls to the 
DCImage API: DCImage.LensRatio and DCImage.LensZone.  An example of the 
Magnifying Lens is shown below. 

 

  

     Magnifying 
               Glass 

Invoice 
Number 

 

Sub DCImage.LensRatio. This subroutine sets the magnification factor of the Magnifier 
Lens Zone.  This subroutine should be called first - before DCImage.LensZone (below).  
The parameter for this call is a decimal value that specifies the relative Zoom factor of 
the lens.  

Setting the parameter for this call to 0.0 removes the Magnifying Lens from the 
DCImage control.  We recommend that you set the Lens ratio to 0.0 when the task 
finishes. For example:  

Sub Pilot_OnEndBatch(eStatus, bCancel) 
Call ImageCtrl.LensRatio(0.0) 
End Sub 

Sub DCImage.LensZone. This subroutine set the position of the Magnifying Lens zone.  
It takes four parameters (X1, Y1, X2, Y2).  The subroutine is optional.  You can 
manually add a Magnifier Zone by dragging a zone onto the DCimage control.  
However, a call must first be made to DCImage.LensRation. 

9 Both calls can be used in events of the Pilot object such as Pilot.OnBeginBatch, 
Pilot_OndEndBatch, Pilot_OnHotKey, etc. – and in events of other controls. 
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The example below shows two command buttons added to a standard Batch Pilot Verify 
form. 

 

 

On! 

Off 

Invoices - Data Entry Panel 

In this example, coding of the “1” Button control’s Click event places a magnifying lens 
right on top of the current image. The operator can move the lens anywhere in the image 
for a better look at fields and their values: 

 

 

 

Coding of the “2” button’s Click event removes the lens. 

 

9 The code for both controls uses the ImageCtrl object (DCImage.ocx) that is built into all 
Batch Pilot forms. 
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Hot Keys of the Data Entry Panel 
The Autoform utility (Page 5) automatically endows a new Data Entry panel with a full 
set of global Hot Keys. Operators can use the Hot Keys to move swiftly and efficiently 
through the contents of the current batch. 

9 The tables in this section describe the panel’s default Hot Keys; Chapter 3 describes the 
steps you take to define additional Hot Keys for your panel. 

Procedures and their Hot Keys 
This table lists a Data Entry panel’s Hot Keys according to the procedures they carry out. 
The table on Page 30 is organized according to Hot Key. 

Both tables display Index and Keycode values that are used by the code that determines 
the Hot Keys’ procedures. 

Procedure Hot Key Index Keycode 

Batch, Doc and Page    

Check Document Integrity and raise condition 
if fails. 

F3 3 114 

Check Expected Docs and raise condition if 
failed. 

F5 5 116 

Go to the next problem page in the batch. Ctrl+N - - 

Go to previous problem page in the batch. Ctrl+P - - 

Go to the next page in the batch. Shift+Ctrl+N - - 

Go to the previous page in the batch. Shift+Ctrl+P - - 

Mark/unmark page for review. F2 2 113 

Mark/unmark page for rescan. Ctrl+Alt+R 41 196690 

Validate data and go to next document F6 6 117 

Run validations. Alt+V 12 65622 

Delete the current document. Alt+D 27 65604 

Quit the current task. Ctrl+Q - - 

Images    

View Image (menu toggle) Ctrl+Alt+I   

Image full view. Alt+E 15 65605 

Image quarter view (counter clockwise). Shift+Alt+Q 8 327761 
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 Procedures and their Hot Keys (continued)  
Procedure Hot Key Index Keycode 

Image quarter view (clockwise). Alt+Q 9 65617 

Restore image from quarter view. F7 7 118 

Scroll up in the image. Ctrl+(KeyPad) Up - - 

Scroll right in the image. Ctrl+(KeyPad) 
Right 

- - 

Scroll down in the image. Ctrl+(KeyPad) 
Down 

- - 

Scroll left in the image. Ctrl+(KeyPad) Left - - 

Zoom out.  Ctrl+(KeyPad) 
Minus 

- - 

Zoom in.  Ctrl+(KeyPad) Plus - - 

Print image. Ctrl+Alt+P 30 196688 

Data Edit Fields    

Next Field Tab   

Previous Field Shift+Tab   

Clear all controls. F11 11 122 

Clear current field. Alt+Z 14 65626 

Delete remaining characters in the current 
field. 

Ctrl+K 39 131147 

Go to next Low Confidence character. F10 10 121 

Go to next Low Confidence character / field. Alt+L 13             
65612 

Go to next Low Confidence field. Shift+Alt+L 40 327756 

Go to next Low Confidence character / field.  
Will not prompt you to go to the next problem 
page. 

Ctrl+Alt+L - - 

Move focus to first field (field with lowest tab 
index) 

Alt+H 16 65608 
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Chapter 5: Data Entry Panels 

 Procedures and their Hot Keys (continued)  
Procedure Hot Key Index Keycode 

Snippets    

Move snippet contents up. Shift+Alt+Number8 
(Number Lock Off) 

31 327718 

Move snippet contents down. Shift+Alt+Number2 
(Number Lock Off) 

32 327720 

Move snippet contents left. Shift+Alt+Number4 
(Number Lock Off) 

33 327717 

Move snippet contents right. Shift+Alt+Number6 
(Number Lock Off) 

34 327719 

Zoom snippet contents in. Shift+Alt+I 35 327753 

Zoom snippet contents out. Shift+Alt+O 36 327759 

Restore default snippet display. Shift+Alt+R 37 327762 

Open/close a Supper Snippet Ctrl+S - - 

CCO Navigation    

Show/hide CCO lines. Alt+R 28 65618 

Show/hide CCO words. Alt+W 29 65623 

Navigate CCO down. Alt+Number2 
(Number Lock ON) 

18 65634 

Navigate CCO down & left. Alt+Number1 
(Number Lock ON) 

17 65633 

Navigate CCO down and right. Alt+Number3 
(Number Lock ON) 

19 65635 

Navigate CCO left. Alt+Number4 
(Number Lock ON) 

20 65636 

Navigate CCO right. Alt+Number6 
(Number Lock ON) 

22 65638 

Navigate CCO up. Alt+Number8 
(Number Lock ON) 

24 65640 

Navigate CCO up and left. Alt+Number7 
(Number Lock ON) 

23 65639 

Navigate CCO up and right. Alt+Number9 
(Number Lock ON) 

25 65641 
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Hot Keys of the Data Entry Panel 

 Procedures and their Hot Keys (continued)  
Procedure Hot Key Index Keycode 

Navigate CCO.  Set word to field value. 
(Check) 

Alt+Number5 
(Number Lock ON) 

21 65637 

Navigate CCO. Append word to field value. 
(Check) 

Ctrl+Alt+Number9 
(Number Lock ON) 

26 196713 

For Future Use    

For Future Use F1 1 112 

For Future Use F4 4 115 

For Future Use Shift + Alt + S 42 327763 

For Future Use Shift + Alt + A 43 327745 

For Future Use Ctrl+Number5 38 131173 

 

Hot Keys and their Procedures 
Hot Key Procedure Index Keycode 

Batch, Doc and 
Page 

   

F3 Check Document Integrity and raise condition if 
fails. 

3 114 

F5 Check Expected Docs and raise condition if failed. 5 116 

Ctrl+N Go to the next problem page in the batch. - - 

Ctrl+P Go to previous problem page in the batch. - - 

Shift+Ctrl+N Go to the next page in the batch. - - 

Shift+Ctrl+P Go to the previous page in the batch. - - 

F2 Mark/unmark page for review. 2 113 

Ctrl+Alt+R Mark/unmark page for rescan. 41 196690 

F6 Validate data and go to next document 6 117 

Alt+V Run validations. 12 65622 

Alt+D Delete the current document. 27 65604 

Ctrl+Q Quit the current task. - - 
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Chapter 5: Data Entry Panels 

   Hot Keys and their Procedures (continued)  
Hot Key Procedure Index Keycode 

Images    

Alt+E Image full view. 15 65605 

Shift+Alt+Q Image quarter view (counter clockwise). 8 327761 

Alt+Q Image quarter view (clockwise). 9 65617 

F7 Restore image from quarter view. 7 118 

Ctrl+(KeyPad) Up Scroll up in the image. - - 

Ctrl+(KeyPad) 
Right 

Scroll right in the image. - - 

Ctrl+(KeyPad) 
Down 

Scroll down in the image. - - 

Ctrl+(KeyPad) 
Left 

Scroll left in the image. - - 

Ctrl+(KeyPad) 
Minus 

Zoom out.  - - 

Ctrl+(KeyPad) 
Plus 

Zoom in.  - - 

Ctrl+Alt+P Print image. 30 196688 

Data Edit Fields    

Tab Next Field   

Shift+Tab Previous Field   

F11 Clear all controls. 11 122 

Alt+Z Clear current field. 14 65626 

Ctrl+K Delete remaining characters in the current field. 39 131147 

F10 Go to next Low Confidence character. 10 121 

Alt+L Go to next Low Confidence character / field. 13             
65612 

Shift+Alt+L Go to next Low Confidence field. 40 327756 

Ctrl+Alt+L Go to next Low Confidence character / field.  Will 
not prompt you to go to the next problem page. 

- - 

Alt+H Move focus to first field (field with lowest tab 
index) 

16 65608 
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Hot Keys of the Data Entry Panel 

   Hot Keys and their Procedures (continued)  
Hot Key Procedure Index Keycode 

Snippets    

Shift+Alt+Number8 
(Number Lock Off) 

Move snippet contents up. 31 327718 

Shift+Alt+Number2 
(Number Lock Off) 

Move snippet contents down. 32 327720 

Shift+Alt+Number4 
(Number Lock Off) 

Move snippet contents left. 33 327717 

Shift+Alt+Number6 
(Number Lock Off) 

Move snippet contents right. 34 327719 

Shift+Alt+I Zoom snippet contents in. 35 327753 

Shift+Alt+O Zoom snippet contents out. 36 327759 

Shift+Alt+R Restore default snippet display. 37 327762 

Ctrl+S Open/close a Supper Snippet - - 

CCO Navigation    

Alt+R Show/hide CCO lines. 28 65618 

Alt+W Show/hide CCO words. 29 65623 

Alt+Number2 
(Number Lock ON) 

Navigate CCO down. 18 65634 

Alt+Number1 
(Number Lock ON) 

Navigate CCO down & left. 17 65633 

Alt+Number3 
(Number Lock ON) 

Navigate CCO down and right. 19 65635 

Alt+Number4 
(Number Lock ON) 

Navigate CCO left. 20 65636 

Alt+Number6 
(Number Lock ON) 

Navigate CCO right. 22 65638 

Alt+Number8 
(Number Lock ON) 

Navigate CCO up. 24 65640 

Alt+Number7 
(Number Lock ON) 

Navigate CCO up and left. 23 65639 
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Chapter 5: Data Entry Panels 

   Hot Keys and their Procedures (continued)  
Hot Key Procedure Index Keycode 

Alt+Number9 
(Number LockON) 

Navigate CCO up and right. 25 65641 

Alt+Number5 
(Number LockON) 

Navigate CCO.  Set word to field value. 21 65637 

Ctrl+Alt+Number9
(Number LockON) 

Navigate CCO. Append word to field value.  26 196713 

For Future Use    

F1 For Future Use 1 112 

F4 For Future Use 4 115 

Shift + Alt + S For Future Use 42 327763 

Shift + Alt + A For Future Use 43 327745 

Ctrl+Number5 For Future Use 38 131173 
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